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 Adagio® SalesAnalysis 9.0A (2011.03.23) 
Release Notes 

The most up-to-date compatibility information is on the Product Compatibility Info link at www.softrak.com. 
 

 
Upgrade Complexity 

 From prior version: Difficult  

Adagio 
Crystal Reports® 8.5-B for Adagio 
DataCare 8.1A, 9.0A 
GridView 6.8A – 9.0C 
Inventory 8.1C (Note 1) 
Invoices 6.8A – 8.1B, 9.0A 
Lanpak 9.0C 
MultiCurrency 8.1B 
ODBC 9.0A 

 
OrderEntry 8.1 D (Note 1) 
Receivables 6.8A – 9.0B 
 

Other 
MS Office 2003, 2007 
MS Windows XP, Vista, 7 

Enhancements and revisions in Adagio SalesAnalysis 9.0A (2011.03.23) 

The changes and improvements to Adagio SalesAnalysis with this release are significant. To make it easier to review the various 
changes that have been made, we have grouped them by function in this release note. 

Generic New Features 

 A charting subsystem has been added to Adagio SalesAnalysis to help analyze trends from sales transactions or statistics. Charts 
can be displayed, printed or exported. Charts can be automatically opened when SalesAnalysis is launched. Pie, Bar and Trend 
Line charts can be defined and the definitions imported and exported. Chart security is available by Group membership.  

 Added new function User Preferences under the File menu. It allows you to set certain options by user that were previously global, 
including options previously found under File | Options, Reports | Report Options and from the Company Profile (company 
background color and On Start-up functions). The preferences can optionally be set for all users and preferences can be printed. If 
no individual user preferences have been set up for a user, all preferences originally set for the Adagio System Administrator, user 
SYS, will be used. 

 You can now specify a desktop background color, image and/or text constant to display on the Adagio desktop. Use this feature to 
display your company logo. Use the text strings to make the company name prominent on the desktop. Any JPG or other graphic 
image can be centered or stretched to fit on the main program desktop. These settings are made on the Appearance tab in the 
new User Preferences function. 

 The option 'Auto-advance smart finder' has been added (in the User Preferences function). It controls whether the focus is on the 
previously found grid or on the search criteria field when the smart finder is opened. Select the option if you want focus to be on 
the next row in the grid, allowing you to press F6, Enter and select each item in turn through the found list. Turn it off if you usually 
want to search by new criteria each time the smart finder is invoked. In either case the position is advanced in the grid each time 
the finder is opened. When the smart finder Grid is opened, you can toggle the focus between the Grid and the selection criteria by 
pressing F6. 

 The option 'Alphabetically sorted field list' has been added (in the User Preferences function). Turn this option on if you want field 
lists in the Column Editor and Filters fields sorted alphabetically. 

 Column Editor settings are now saved by grid by user by database. 

 Added the option 'Exclude Ranges' to Report Options (now in the new User Preferences function). If 'Remember report options' is 
on and 'Exclude Ranges' is also on, field ranges in general (including date ranges) are not remembered but other report settings 
are remembered. 

 Optional fields have been added to SA transactions records. Added Header Optional Field Titles and Detail Option Field Titles on 
the Options tab in the Company Profile. Optional fields can be shown in Online Inquiries, Edit Sales Data, GridView and Crystal 
Reports for Adagio. Optional field values are retrieved from Adagio Invoices and OrderEntry. You can specify which Optional fields 
are sent to SA from Invoices and OrderEntry in the Company Profile of those modules. The Scan Sales Data function also 
supports optional fields. 

 Header and Detail optional fields to send to SalesAnalysis have been added to the SA Opt. Fields tab added to the Company 

http://www.softrak.com/
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Profile in Adagio Invoices which appears when SA 9.0A data is present. Header optional fields to send to SalesAnalysis have 
been added to the SA Interface tab added to the Company Profile in OrderEntry which appears when SA 9.0A data is present. 

 Optional Fields have been significantly improved with the addition of edit controls to validate optional field entry within and across 
an Adagio module(s). Users can control whether a text field, combo box or Finder field is used to validate optional field entries. 
Data can be restricted as to length and case. Fields shared between modules (customer and item optional fields) will automatically 
inherit the same validation rules. Module by module control of field entry and validation is available. 

 You now have explicit control of how a document record is displayed in the Edit Sales Data grid. File | Edit Styles allows the 
creation of named styles with a colored background and font color. User control of font attributes bold and italic are also 
supported. Named styles may be assigned to individual transactions by editing a record or importing the style you wish to use. The 
style controls the display of a transaction in the grid. For example, use this feature to highlight transactions where the invoice has 
not been paid. Adagio Styles are shared globally between all Adagio modules and company datasets. Display Styles settings, 
Manual and Automatic, have been added to the edit order screen. The manual style has been added to the import orders function. 

 Display just the records you need in Edit Sales Data grid. User defined filters can select and instantly display transactions that 
meet specific criteria in a user specified sequence. Column settings are saved by grid for each filter by user by database. Up to 5 
selection rules can be defined per filter. Compare data elements to a constant value (Total Invoice > $10,000), another data 
element (Amount <= Cost) or, in the case of dates, to a “floating date range” (Date is This Week). Grid Filters also allow you sort 
grids by multiple fields. Grid Filters may be public or private. Filters are refreshed automatically when transactions are retrieved or 
scanned, and when a Data Integrity Check is performed (including in DataCare) or on demand. Styles can be automatically 
applied to records that belong to a specific group, making it easy to identify important records according to criteria that you 
choose. The Display Style may also be set manually in the document. The Apply Styles function in the Maintenance menu allows 
you to apply multiple filter styles simultaneously. Filters can be toggled on/off on the grids. 

 Data Integrity Check (DIC) will automatically reset all filter Styles used based on the Style priority set in the transaction filter. For 
transactions that no longer meet any filter criteria, any filter style previously assigned to them is removed and reset to the Standard 
style. No messages or warnings are given in DIC. 

 Styles and Grid Filters for customer and item grids are supported in the Customer and Item inquiry functions when Adagio 
Receivables is 9.0A or higher and Adagio Inventory is 8.1C or higher. 

 Item Number segments are available as separate fields in grids, finder, smart finder and GridView. 

 Added an Excel Direct button to the Edit Sales Data function. Use the 'Enable SF Export' option in Edit User to enable or disable 
the Excel Direct button. 

 New toolbar icons provide a cleaner look and differentiate this new version visually.  

 Grids, filters, and finders now show the lookup values instead of the raw data values for typed fields. For example in SA 
Transactions: Type shows Line, Misc. Charge and Tax instead of L, M or T; RecordSource shows OrderEntry, Invoices, Imported, 
etc. instead of OE, QI and IP; and ItemSource shows Inventory, Invoices, Tax, etc. instead of IC, QI, or TX. Lookup values are 
also shown for customers and items. 

 The performance of standard reports has been improved. 

Edit and View functions 

 The View Customer function in SalesAnalysis supports the option to sort transactions and notes added in Receivables 9.0B. 

 Listing button added on the Group Setup window prints all options or enabled options only for a range of groups. 

 Display Styles settings, Manual and Automatic, have been added to the edit sales data screen. The manual style has been added 
to the import transactions function. 

 Edit Data supports new the fields in transactions, including Document Number, Customer and Item Report Group, Optional Fields,  
Original Invoice, PO Number and Display styles. 

 The Edit Sales Data function remembers (globally) the choice for sorting the grid. 

Transactions file 

 Added a 12 character Document Number field to transactions, allowing for the full 12 character document number from Adagio 
Invoices and in future versions of OrderEntry to be recorded in SalesAnalysis. The document number fields (invoice and credit 
note number) were sent to the Reference field in SalesAnalysis in previous versions. The Reference field was only 8 characters in 
SalesAnalysis, causing the document number from Invoices to be truncated in some cases. 

 The Reference field has been increased from 8 to 12 characters and is now populated from the Reference field in Adagio Invoices 
and OrderEntry rather than being set to the invoice/credit note number. 
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 The Order Number field has been increased from 8 to 12 characters to support a future increase in size of the order number field 
in OE. 

 QI Item field added to accommodate "Composite View" capability in GridView 9.0C and higher. 

 Added Item Description field to transactions. Turn on the option 'Use Desc. in SRTRANS' in the Company Profile to use this field. 
It can be used in the Online Inquiry function, Edit Data, GridView and Crystal Reports for Adagio. The conversion to 9.0A sets it to 
the item description saved by SA the last time the item was on a document retrieved into SA (i.e. from SA's Item Description file). 

 Added Original Invoice field from credit notes to transactions. Conversion sets this new field to blank. 

 Added PO Number field to transactions. It is populated on retrieve and scan from customer's PO Number field in Adagio Invoices. 
It will be used in future versions of OrderEntry. For the current version of OE users typically enter the customer's purchase order 
number in the Reference field on the order. The conversion sets this new field to blank. 

 Added JobCost Job, Phase and Category fields to the transaction file. They are populated by the retrieve and from Adagio 
Invoices functions. They can be shown in on-line inquiries and the Edit Sales Data function. The conversion sets these fields to 
blanks. 

 Add Customer and Item Report Groups fields to trans file, and Inquires and Edit. The conversion sets these fields to blanks. 

On-line Inquiry 

 Added 'Use desc. in SRTRANS' option to the Options tab in the Company Profile. If set, online inquiries in SA will use the new 
item description field in the transaction file. It is set to the actual description from the OE document (which could have been 
modified from the default IC item description during entry), rather than the item description saved by SA, which comes from OE the 
last time the item was on a document retrieved into OE. Previous versions of OE did the latter. 

 The Date Paid indicator field is now available in On-line Inquiry function allowing you to create inquiries showing transactions for 
which invoices have or have not been paid. 

 On-line Inquiry supports new fields in transactions: Reference, cust and item report group, manual and auto style, Original Invoice, 
PO Number. 

Maintenance functions / Retrieve and Scan Sales Data 

 The OrderEntry transaction batch file for SA is now created and updated by Day End in OE, rather than requiring you to print and 
clear the OE shipment and credit note audit lists before you can retrieve OE transactions into SA. This feature requires OrderEntry 
8.1D or higher. 

 Added the 'Skip 0 qty/amts lines on Invoices retrieve?' option to the Options tab in the Company Profile. If set, SA does not 
retrieve detail lines that have zero quantity, amount and cost from Adagio Invoices. Use this option if you do not want Adagio 
Invoices items that that are text only (no numeric fields) to be retrieved or scanned into SA. 

 The Retrieve Sales Data and Scan Sales Data functions support the new fields in transactions when retrieving from Adagio 
Invoices and OrderEntry support. 

 Added 'Update desc. from OrderEntry' and 'Update desc. from Invoices' functions in the Utilities menu. These functions are 
enabled when you turn on the option 'Use Desc. in SRTRANS' in the Company Profile to use the Item Description field added to 
transactions. 

Archive and Restore 

 Archive and Restore functions support all new fields in SA transactions. Note: not all fields can be used as ranges in 
Archive/Purge/Restore templates but all new fields are archived and restored. 

Import and Export 

 Import/Export supports Excel® 2007 format (.xlsx) allowing for more than 65,535 rows in import and export files. Spreadsheets no 
longer need to be re-saved in Excel 97-2003 format (.xls) before they can be imported.  

 Import / Export transactions functions support new fields in transactions: Reference, Customer Report Group, Item Report Group, 
Manual style, Original Invoice, PO Number, and Item Description. 

Install Changes 

 This version moves toward our goal of a more Windows 7 friendly environment for installation. If you are installing to a mapped 
network drive that is normally accessible, but you cannot see it during the install when attempting to select a drive or folder, you 
can now install by browsing to the correct folder using the Universal Naming Convention (UNC), for example 
\\myserver\accounting\. This avoids having to adjust the User Account Control settings, which requires you to restart your 
computer and temporarily grant Administrative privileges to the user if they are not an administrator. 
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 This version simplifies installation by removing any consideration of the location of the Report Tables Drive (RTD) by the install 
and program in virtually all cases. Therefore the install no longer prompts for the RTD. 

 The install writes to the master install log file "AdagioMasterInstall.log" in the \softrak\system folder. An entry is written to this log 
when any full, upgrade or SP for any Adagio module (with a release date of March 2011 or later) is installed. It shows the version 
installed and the version being replaced, the name of the Windows user who did the install and the rights for that user. An entry is 
also written to the log when an updated version of the Adagio Data Source (ADS) is installed, showing the version installed and 
the version being replaced. This log can be used to quickly determine the install history for all Adagio programs. 

 When you select the 'Backup Files' option during an install, the replaced files are now saved in a subfolder named YYYYMMDD in 
the BACKUP folder, under the programs destination folder (rather than the BACKUP folder itself, where extensions need to be 
changed to .001, .002, etc. when there are multiple versions of the same file). 

 The install includes an option allowing you to skip creating entries under Windows Start for cases where you will be manually 
creating an icon for the user to start Adagio and do not want them starting from Windows Start. During the install, uncheck the 
option 'Start Menu programs'. This avoids having to delete or change the Windows Start entry that would have been created. 

 The install no longer checks the Opportunistic Locking setting (Oplocks) on the workstation. 

 The Opportunistic Locking setting (Oplocks) on the workstation is no longer checked when the program is started. 

 The System Status function in the Help menu (chksys.exe) no longer prompts you to disable Oplocks. It displays the current 
Oplocks setting and allows you to change it. The 'Check R/W Status', 'Check Specific Folder' function now supports UNC browse, 
whereas before you would have had to turn UAC off to use it. 

 SetServerForAdagio and SetReportsTablesDrive utilities have been updated. The latter should virtually never be needed at an 
Adagio site once any Adagio module dated March 2011 or later has been installed. 

Problems Fixed 

 If 'Purge from Current after days' was set to 0 days in OrderEntry the Ship To code was blank for invoices retrieved into 
SalesAnalysis. 

 The Territory field contained only 2 of 6 characters when transactions when retrieved from OrderEntry and you were using 
Receivables 9.0A or higher. 

 Fixed problems that may occur in Online Inquiries if the Adagio Data Sources (ADS) is version 1.12.54.2681 or 1.12.54.2689. 
These versions of ADS were installed by Adagio Receivables 9.0B (2010.09.10) and GridView 9.0C (2010.10.14). You can check 
the version of ADS in the Help | About function from any Adagio module. 

 Date fields are now shown (rather than being blank) on the summary in Online Inquiry if the Prefixed Document number has been 
selected to summarize, as this guarantees the date field will be unique for each document. Otherwise asterisks are shown in the 
date on the summary. 

 When you sent results from an Online Inquiry to Excel, if the Customer field was an exported column, that column heading in 
Excel wrapped incorrectly. 

 When exporting transactions and selecting to export only Items, the very last line of the export was a misc. charge or tax detail. 

 Corrected calculation of certain fields that are not included in the import file when importing transactions to a multi-currency 
database. 

 On a multi-currency database, if your import file included the Price List but not the Base Price and the item was not in the alternate 
price list, the Base Price in source currency is now set to zero rather than the home currency price from the master item. 

 A user who does not have access to Item Inquiry with Sales/Costs will have the item costing fields automatically hidden so that 
access to the column editor may be granted without compromising the confidentiality of these figures. 

 A user that does not have access to 'Enable SF Export' could still see the Excel Direct button on both the Summary and Detail 
screens in the Online Inquiry. 

Enhancements and revisions in earlier versions of Adagio SalesAnalysis 

 Refer to the Readme help file for details of enhancements and revisions in earlier versions or Historical Enhancements under 
Products on Softrak's web site. 

Installing 

To install Adagio SalesAnalysis from the Adagio Product CD you need the serial number and install code from the Product Label that 
came with your CD or in the email from Softrak Systems. 

http://www.softrak.com/products/reference/ears/index.php
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If you are installing an upgrade, you need the serial number and install code that came with your upgrade. A previous version of Adagio 
SalesAnalysis should already be installed on your computer before installing the upgrade. If a previous version is not already installed, 
you can still install the upgrade. After entering the upgrade serial number and install code, you will also have to enter the serial number 
and install code from your previous version. 

Read the sections below before installing an upgrade to 9.0A from an earlier version. 

If you are installing a Service Pack, you do not need to enter a serial number or install code. However, a previous version of Adagio 
SalesAnalysis 9.0A must be installed before the Service Pack can be installed. 

To install Adagio SalesAnalysis (or an upgrade), insert the CD in the drive. If the install program does not start automatically, run 
ADAGIO.EXE from the root of the CD. Or, if Adagio SalesAnalysis was downloaded, run the program file you downloaded. Once the 
install program is running you can click the View button for detailed instructions. If Adagio SalesAnalysis is installed on a network, you 
must also do a workstation install for each workstation running Adagio SalesAnalysis. Refer to the manual or “Installing on a network” in 
the Readme help for instructions. 

To install the Adagio SalesAnalysis Service Pack, run the Service Pack program and follow the instructions on the screen. After 
installing the Service Pack, a workstation install may be required at each station running Adagio SalesAnalysis. To determine if a 
workstation install is required, start Adagio SalesAnalysis at the workstation. The workstation install will be automatically started if 
required. Note: If you are updating multiple applications at the same time, it may be faster to run the all workstation install to update all 
applications at once on the station. Refer to “Installing on a Network” in the Readme for instructions. 

Upgrading to this Version – considerations before installing an upgrade  Upgrade Complexity:  Difficult  

Adagio SalesAnalysis 9.0A is a major upgrade with significant changes to the data structure, containing many changes and new 
features. It is very important to review the information below before installing an upgrade. 

Note 1: Adagio SalesAnalysis 9.0A requires compatibility upgrades and Service Packs to several other Adagio modules. Do not install 
SalesAnalysis 9.0A until you are certain all the compatibility upgrades required at your site have been released by Softrak and you 
have them available to install. 

Some of the required compatibility releases of other modules may not be available until sometime after SalesAnalysis 9.0A has been 
released. 

Adagio SalesAnalysis 9.0A requires Adagio OrderEntry to be version 8.1D (2011.03.16) or higher. The installation of OE and SA, and 
the conversion of data, can be done in any order. However, you should open SA 9.0A at least once after converting OE data, before 
running Day End in OE. If this is not done, you will receive a series of messages when you open SA, prompting you to retrieve 
transactions from OE before the database can be opened. If you are also converting OE from earlier versions than 8.1D you may also 
get these messages. No data will be lost in any case. 

An Item Description field was added to transactions. The conversion to 9.0A sets it to item description saved in the SA Item Description 
File the last time the item was on a document retrieved into SA. If the is no description in that file the converted data will have a blank 
item description. This may be the case for transactions that were retrieved by older versions of SA. To avoid this possibility you should 
run the Update Item Description File function prior to installing the 9.0A upgrade. 

SalesAnalysis 9.0A requires Adagio Inventory to be version 8.1C or higher. 

SalesAnalysis 9.0A requires Adagio SalesCQ to be version 8.1B (2011.03.18) or higher. 

SalesAnalysis 9.0A requires Adagio Invoices to be version 9.0A (2010.03.17) or higher if you use Invoices 9.0A. SA 9.0A is compatible 
with 8.1B and earlier versions of Invoices when Receivables 8.1A or earlier is used. 

SalesAnalysis 9.0A requires Adagio Lanpak to be version 9.0C or higher. 

SalesAnalysis 9.0A requires Adagio MultiCurrency to be version 8.1B or higher. 

SalesAnalysis 9.0A requires a database conversion. You should perform a Data Integrity Check in your current version of SA before 
installing the new version and converting your database. Any errors should be rebuilt or dealt with in your current version to ensure a 
successful conversion. 

Adagio SalesAnalysis is one of the top modules for which custom reports and views are likely to have been created in Crystal Reports 
for Adagio and Adagio GridView. These reports and views will require conversion and adjustment for use with 9.0A. You should not 
install or convert SA until you have a plan in place to update any custom reports and views critical to your operation. See the 
'Converting custom reports and views' section below for details. 

Upgrading to this Version – installing the upgrade 

Adagio SalesAnalysis 9.0A will be installed to the \softrak\salesanalysis folder. Previous versions were installed in \softrak\srwin. The 
previous version will be uninstalled. Uninstalling the previous version removes everything from the program folder that got installed but 
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leaves everything else that you may have created manually, including the CustomRP, ModRP and Views folders. 

The install checks that you have the required versions (as listed in the section above) and displays a warning if the version you have is 
not compatible. You may proceed as long as you have the required compatibility upgrades to the other modules and are prepared to 
install them after completing the installation of SalesAnalysis 9.0A. 

The upgrade install cannot change any custom icons you may have created to launch SalesAnalysis and they will continue to run your 
previous version if it was not uninstalled or will display a “missing shortcut” error if it was uninstalled. You must change these icons 
manually to run SalesAnalysis from \softrak\salesanalysis\salesanalysis.exe. 

Upgrading to this Version – converting your database 

You can convert your SA database at any time. You do not need to retrieve from OrderEntry or Invoices first. You do not have to run 
Day End in OrderEntry or print and clear the audit lists before converting your data. 

To start the conversion, open your current database that used your previous version of SA. A warning is displayed indicating the 
database will be converted and a backup must be made. The program allows you to make a back up at this time, before proceeding 
with the conversion. 

The conversion to 9.0A could take a significant period of time on databases with a large number of transactions over a network. 
For large databases, you may want to copy your database to a local machine, convert the data, and then copy it back. The conversion 
on a local drive will be much faster. We strongly recommend you contact your Adagio dealer or consultant for assistance with this 
procedure. 

Note: If the conversion is aborted or does not complete for any reason you must restore your backup. Before restoring your backup you 
MUST first delete the SA data files (SR*.ddd, where ddd is your company data file extension). Failure to delete the SA data files before 
restoring your backup will result in future problems and database corruption. In general you must always delete the existing database 
before restoring a backup and be certain your backup is viable before deleting the database. 

Upgrading to this Version – after conversion 

The program folder moves to \softrak\salesanalysis for version 9.0A. Previous versions were installed to \softrak\srwin. Likewise, the 
program filename changes to SalesAnalysis.exe for version 9.0A. Previous program versions were named srwin.exe. 

The Windows Start list entry for version 9.0A will default to „SalesAnalysis 9‟. The Windows Start list entry for earlier versions defaulted 
to „SalesAnalysis‟, and will be removed. When installing an upgrade you should change any icons on your desktop or in desktop folders 
to run SalesAnalysis using the new program name and folder (see above paragraph). 

Settings made in the Column Editor to grids, finders and smart finders for previous versions may to be adjusted. 

The File | Options, Field Verification option has been removed. Fields are always verified during entry.  

Statistics Field Selection is now on a new tab in User Preferences. In previous versions the selection was done in security Groups. 

The Original Invoice field from credit notes was added to the transaction file. The conversion sets this new field to blank for existing 
transactions. It is possible to use the Scan Sales Data function to populate this field for existing transactions. However, this function 
does not update existing records but only adds new records. Therefore you would have to delete or archive all transactions and then 
scan to get them back. You must be certain your OrderEntry and/or Invoices history contain ALL the transactions you require in SA. 
Therefore this procedure is not recommended unless the Original Invoice field is very important to you. 

Upgrading to this Version – converting custom reports and views 

Reports 

If you have modified any of the standard reports installed by Adagio SalesAnalysis, you will have to redo those modifications for 
SalesAnalysis 9.0A. Modified reports are files with an .rpt extension that you copied from \softrak\srwin\StandardRP to 
\softrak\srwin\ModRP and modified using Crystal Reports for Adagio. The standard report filenames for 9.0A are similar to those in 
earlier versions. Your modified reports from your prior version will be copied to the folder \softrak\salesanalysis\ModRP.priorversion. Re-
modified reports must be placed in \softrak\salesanalysis\ModRP for SalesAnalysis 9.0A. 

Installing a SalesAnalysis 9.0A upgrade does not delete your original modified reports in \softrak\srwin\ModRP. When you are certain 
these reports are no longer needed, you can delete that folder. 

Custom reports created in Crystal Reports for Adagio for earlier versions of SalesAnalysis will have to be modified or recreated for use 
with SalesAnalysis 9.0A databases. Your custom reports from your prior version will be copied to the folder 
\softrak\salesanalysis\CustomRP.priorversion. Recreated custom reports must be placed in \softrak\salesanalysis\CustomRP for 
SalesAnalysis 9.0A. Installing a SalesAnalysis 9.0A upgrade does not delete your original custom reports in \softrak\srwin\CustomRP. 
When you are certain these reports are no longer needed, you can delete that folder. 
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See the Tech Note entitled “Converting Crystal Reports for Adagio SalesAnalysis 9.0A” and a on Softrak‟s website under Support | 
Technical Tips http://www.softrak.com/partners/resources/technicaltips/technicaltips.php. In addition to this document there is short 
video entitled "ConvertingReportsforSR90A" showing how to convert a report. 

The „Installed only‟ method of selecting tables for Adagio when defining reports in Crystal Reports for Adagio using ADAGIO.SSI to find 
your database is not supported for SalesAnalysis 9.0A. Find your database by the alternate method of searching for the SalesAnalysis 
company profile (global) file „SRGLOB‟ instead. Existing reports are not affected by this change. 

Views 

GridView views created for earlier versions of Adagio SalesAnalysis must be modified or recreated or using tables from „Adagio 
SalesAnalysis 9.0A‟. GridView 9.0A and higher has the ability to convert existing views to a new table. 

Views from your prior version will be copied to the folder \softrak\salesanalysis\views.priorversion. Recreated views must be placed in 
\softrak\salesanalysis\views for SalesAnalysis 9.0A. Installing a SalesAnalysis 9.0A upgrade does not delete your original views in 
\softrak\crwin\views. When you are certain these views are no longer needed, you can delete that folder. 

See the Tech Note entitled “Converting GridView views for Adagio SalesAnalysis 9.0A” on Softrak‟s website under Support | Technical 
Tips http://www.softrak.com/partners/resources/technicaltips/technicaltips.php. In addition to this document there is short video entitled 
"ConvertingViewsforSR90A" showing how to convert a view. 

You may find the Adagio Data Dictionary Export Tool useful for comparing tables in the Adagio SalesAnalysis 9.0A dictionary to 
previous versions using Excel. The exporter can be found under on Softrak‟s website Support | Technical Tips 
www.softrak.com/resources/technicaltips/technicaltips.php. 

A new Composite dictionary “Adagio {Composite Tables 9.0B}” that links to SalesAnalysis 9.0A tables is installed for use with GridView. 
It replaces “Adagio {Composite Tables 9.0A}” for use with SalesAnalysis 9.0A. Views using the 9.0A composite dictionary can be 
converted to use the new 9.0B dictionary. However, if you have GridView 9.0C or higher, instead, we recommend you redefine your 
views using the new call GetExternalData(S, S, list), and the composite dictionary will not be needed. See the GV 9.0C documentation 
for details. Note: the composite dictionary will not be updated for future upgrades of Adagio modules because GV 9.0C allows you to 
create your own composite views using any related tables. 

Upgrading to from a version older than 8.1B 

The Previously Opened database list is now saved by Adagio User rather than for all users. The first time an existing user or a new user 
logs into Adagio SalesAnalysis they will be asked “Would you like your historical company access list set up?” Answer yes to have 
Adagio SalesAnalysis add all entries from the Previously Opened list from your prior version of Adagio SalesAnalysis. It is no longer 
possible for all users to share the same Previously Opened list. 

Settings remembered from the last use of the Set Paid Invoices and Statistics Inquiry functions are lost when you convert and must be 
re-selected the first time these functions are used after the conversion. 

-- end -- 
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